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[bookmark: _Toc284509797]Usage Notes
Overview
At the time of testing (September 30, 2010), Word 2010 provides a set of accessibility features that is sufficient to enable the production of accessible digital office documents. In addition, Word 2010 includes an accessibility checking feature.
What’s an “Office Document”?
You should use these techniques when you are using Word 2010 to create documents that are: 
· Intended to be used by people (i.e., not computer code),
· Text-based (i.e., not simply images, although they may contain images),
· Fully printable (i.e., where dynamic features are limited to automatic page numbering, table of contents, etc. and do not include audio, video, or embedded interactivity),
· Self-contained (i.e., without hyperlinks to other documents, unlike web content), and 
· Typical of office-style workflows (Reports, letters, memos, budgets, presentations, etc.).
If you are creating forms, web pages, applications, or other dynamic and/or interactive content, these techniques will still be useful to you, but you should also consult the W3C-WAI Web Content Accessibility Guidelines (WCAG 2.0) because these are specifically designed to provide guidance for highly dynamic and/or interactive content.
[bookmark: _Toc275959752]File Formats
The default file format for Word 2010 is Office Open XML (DOCX). 
In addition, Word 2010 offers many other word processor and web format saving options. Most of these have not been checked for accessibility, but some information and/or instructions are available for the following formats in Technique 12 (below):
· MS Word 
· PDF 
· HTML
Document Conventions
We have tried to formulate these techniques so that they are useful to all authors, regardless of whether they use a mouse. However, for clarity there are several instances where mouse-only language is used. Below are the mouse-only terms and their keyboard alternatives:
*Right-click: To right-click with the keyboard, select the object using the Shift+Arrow keys and then press either (1) the “Right-Click” key (some keyboard have this to the right of the spacebar) or Shift+F10.
Disclaimer and Testing Details:
Following these techniques will increase the accessibility of your documents, but it does not guarantee accessibility to any specific disability groups.  In cases where more certainty is required, it is recommended that you test the office documents with end users with disabilities, including screen reader users.
The application-specific steps and screenshots in this document were created using Microsoft Word 2010 (ver.14.0.4762.1000, Windows XP, Aug. 2010) while creating a DOCX document.  Files are also easily saved as other file formats (see Technique 12, below).
[bookmark: _Toc284509798]Technique 1. Use Accessible Templates
All office documents start with a template, which can be as simple as a blank standard-sized page or as complex as a nearly complete document with text, graphics and other content. For example, a “Meeting Minutes” template might include headings for information relevant to a business meeting, such as “Actions” above a table with rows to denote time and columns for actions of the meeting.
Because templates provide the starting-point for so many documents, accessibility is critical. If you are unsure whether a template is accessible, you should check a sample document produced when the template is used (see Technique 11, below). 
Word 2010’s default template for new documents is a blank page. The basic installation also includes blank business card, blank label templates, and other blank office-related documents.  These are all accessible by virtue of being blank. 
It is possible to create your own accessible templates from scratch in Word 2010.  As well, you can edit and modify the existing prepackaged templates, ensuring their accessibility as you do so and saving them as a new template.
To create an accessible template
1. Create a new document (from the default blank template or from one of the prepackaged templates)
2. Ensure that you follow the techniques in this document
3. When you are finished you should also check the accessibility of the document (see Technique 11, below)
4. Go to menu item: File > Save As
5. Select Templates
6. In the Save as type list, select Word Template
7. In the File name box, type a name for the template.  Using a descriptive File name (e.g., “Accessible Memo Template”) may increase the prominence of the accessibility status.  As well, filling in the text box labeled Tags with the term “accessibility” may improve its searchability as an accessible file.
8. Select Save
[image: ]
To select an accessible template
1. Go to menu item: File > New
2. Under Available Templates, select My Templates
[image: ]
3. In the New document dialog, select your accessible template from the list
4. Select OK
[image: ]
5. A new document based on the template will be displayed. If you have chosen an accessible template, the document will be accessible at this point. As you add your content (e.g., text, images, etc.), ensure that you consult the sections that follow to preserve accessibility.
[bookmark: _Toc284509799]Technique 2. Specify Document Language
In order for assistive technologies (e.g., screen readers) to be able to present your document accurately, it is important to indicate the natural language of the document.  If a different natural language is used for a paragraph or selected text, this also needs to be clearly indicated.
To change the default language
1. Go to menu item: File
2. Select Options from the list in the left window pane
3. Select Language from the list in the left of the Options dialog
4. Under Choose Editing Languages, select the editing language you want to use
Note: to add an editing language, select the language from the drop down list labeled [Add additional editing languages] 
5. Select Set as Default
6. Close all Office 2010 programs and open them again for the changes to take effect
[image: ]

Word 2010 has an automatic language detection mechanism, which can automatically detect the language of your text.  If you type a section of text in a different language than the rest of your document, Word 2010 will programmatically mark the language of that section of text appropriately.  
To turn on automatic language detection
1. Go to menu item: Review
2. In the Language section, select the Language button
3. Select Set Proofing Language
4. In the Language dialog, select the Detect language automatically check box
[image: ]
To apply a language directly to selected text
1. Select the text
2. Go to menu item: Review
3. In the Language section, select the Language button
4. Select Set Proofing Language
5. In the Mark selected text as box, select the language from the list
6. Select OK
[image: ]
[bookmark: _Toc284509800]Technique 3. Provide Text Alternatives for Images and Graphical Objects
When using images or other graphical objects, such as charts and graphs, it is important to ensure that the information you intend to convey by the image is also conveyed to people who cannot see the image.  This can be accomplished by adding concise alternative text to of each image. If an image is too complicated to concisely describe in the alternative text alone (artwork, flowcharts, etc.), provide a short text alternative and a longer description as well. 
Tips for writing alternative text (“Title” in Word 2010)
· Try to answer the question "what information is the image conveying?"
· If the image does not convey any useful information, leave the alternative text blank
· If the image contains meaningful text, ensure all of the text is replicated
· Alternative text should be fairly short, usually a sentence or less and rarely more than two sentences
· If more description is required (e.g., for a chart or graph), provide a short description in the alternative text (e.g., a summary of the trend) and more detail in the long description, see below
· Test by having others review the document with the images replaced by the alternative text
Tips for writing longer descriptions (“Description” in Word 2010)
· Long descriptions should be used when text alternatives (see above) are insufficient to answer the question "what information is the image conveying?"
· In some situations, the information being conveyed will be how an image looks (e.g., an artwork, architectural detail, etc.). In these cases, try to describe the image without making too many of your own assumptions.
· One approach is to imagine you are describing the image to a person over the phone
· Ensure that you still provide concise alternative text to help readers decide if they are interested in the longer description
Alternatively, you can include the same information conveyed by the image within the body of the document, providing the images as an alternate to the text. In that case, you do not have to provide alternate text within the image.
To add alternative text to images and graphical objects
1. Right-click* the object
2. Select Format Picture…
3. Select the Alt Text option from the list
4. Fill in the Title.  If more description is required (e.g., for a chart or graph), provide a short description in the Title (e.g., a summary of the trend) and more detail in the Description.
[image: ] At this time, if a Word 2010 document is ever saved to HTML, the Title and Description fields are combined into a single entry within the HTML <alt> tag. [Tested: September 30th, 2010]
[image: ]
[image: Caution] When inserting a very small image, or resizing a larger image to be much smaller, Word 2007 assumes that the image is intended to be a bullet-point for a bulleted list.  Once Word 2007 defines the image as a bullet, the option to add alternative text disappears.  Select Undo, to redefine the bullet as an image.  When you right-click* the image, select Format Picture… and select the Alt Text tab in the Format Picture dialog.  Alternative text can be found, or can be entered, into the Alternative text box.
[bookmark: _Toc284509801]Technique 4. Avoid “Floating” Elements
When images and objects are inserted into Word 2010 documents they default to being an “inline object”.  Inline objects keep their position on the page relative to a portion of the text.  
A “floating” object keeps its position relative to the page, while text flows around it.  As content moves up or down on the page, the object stays where it was placed.  To ensure that images and objects remain with the text that references it, always position it as an inline object.
Similarly, avoid placing drawing objects directly into the document (e.g., as borders, to create a diagram). Instead, create borders with page layout tools and insert complete graphical objects.
To prevent an image or object from “floating”
1. Select the object
2. Go to menu item: Page Layout
3. Select Position from the Arrange section
4. Select In Line with Text
[bookmark: _Toc284509802]Technique 5. Use Headings
Any documents that are longer than a few paragraphs require structuring to make them more straightforward for readers to understand. One of the easiest ways to do this is to use “True Headings” to create logical divisions between paragraphs. True headings are more than just bolded, enlarged, or centered text; they are structural elements that order and levels provide a meaningful sequence to users of assistive technologies.
Tips for headings
· Use the default headings styles provided (“Heading “, “Heading 2”, etc.)
· Nest headings properly (e.g., the sub-headings of a “Heading 1” are “Heading 2”, etc.)
· Do not skip heading levels
To apply headings to selected text
1. Select text
2. Right-click* and select Styles
3. Select the heading style from the list
To apply headings using the Styles toolbar
1. Select text
2. Go to menu item: Home
3. In the Styles section, select the heading you wish to apply
Note: You can scroll through the multiple heading styles using the arrows on the right side of the Styles section.  You can also change the Style design by selecting the Change Styles button on the right.
To modify heading styles
1. Go to menu item: Home
2. In the Styles section, right-click* the style you wish to use from the Styles Gallery
3. Select Modify
4. In the Modify Style dialog, make the appropriate changes to style characteristics
5. Select OK
To return to the default heading styles
1. Go to menu item: Home
2. In the Styles section, select Change Styles
3. Select Style Set
4. Select Word 2010 from the list
[bookmark: _Toc284509803]Technique 6. Use Named Styles
As with “True Headings” (see Technique 5), you should attempt to make use of the named styles that are included with the office application (e.g., “emphasis”, “caption”, etc.) before creating your own styles or using the character formatting tools directly. Named styles help your readers understand why something was formatted in a given way, which is especially helpful when there are multiple reasons for the same formatting (e.g., it is common to use italics for emphasis, Latin terms and species names).
For more information on formatting using named styles, see Technique 9.
Note: While office application suites support headings in much the same way, the named styles often differ. 
To use default named styles
1. Default named styles can be applied the same way as headings (see Technique 5).
[bookmark: _Toc284509804] Technique 7. Use Built-In Document Structuring Features
7.1 Tables
When using tables, it is important to ensure that they are clear and appropriately structured. This helps all users to better understand the information in the table and allows assistive technologies (e.g., screen readers) to provide context so that the information within the table can be conveyed in a meaningful way. 
Tips for tables
· Only use tables for tabular information, not for formatting, such as to position columns.
· Use “real tables” rather than text formatted to look like tables using the TAB key or space bar. These will not be recognized by assistive technology.
· Keep tables simple by avoiding merged cells and dividing complex data sets into separate smaller tables, where possible.
· If tables split across pages, set the header to show at the top of each page. Also set the table to break between rows instead of in the middle of rows.
· Create a text summary of the essential table contents. Any abbreviations used should be explained in the summary. 
· Table captions or descriptions should answer the question "what is the table's purpose and how is it organized?" (e.g., "A sample order form with separate columns for the item name, price and quantity").  
· Table cells should be marked as table headers when they serve as labels to help interpret the other cells in the table.
· Table header cell labels should be concise and clear.
· Ensure the table is not “floating” on the page (see Technique 4).
To add a table with headings
1. Go to menu item: Insert
2. In the Tables section, select the Tables icon
3. Select the number of rows and columns you would like your table to have
4. Select the table and a Table Tools menu item should appear
5. Go to menu item: Table Tools > Design
6. In the Table Style Options section, select the Header Row check box
Note: Whenever possible, keep tables simple with just 1 row of headings.
[image: ] At this time, Word 2010 does not properly communicate the location of header rows to assistive technologies. The following work-around may be used with some versions of JAWS:
Work-around: To specify for JAWS  that a table row is a header row
1. Place the cursor in any cell within the row containing headings
2. Go to menu item: Insert
3. In the Links section, select Bookmark
4. Type “ColumnTitle” and press Enter
Note: Only mark one cell in the row.
7.2. Lists
When you create lists, it is important to format them as “real lists”. Otherwise, assistive technologies will interpret your list as a series of short separate paragraphs instead of a coherent list of related items.
To create an ordered or unordered list
1. Go to menu item: Home
2. In the Paragraph section, select the Bullets icon for unordered lists or select the Numbering icon for ordered lists
3. To choose a different list format, select the arrow beside the icon
4. Select a format from the format Library that appears in the drop-down menu
To modify list styles
1. Go to menu item: Home
2. In the Paragraph section, select the arrow beside the Bullets icon for unordered lists or select the arrow beside the Numbering icon for ordered lists
3. Select Define New Bullet… to create a new unordered list format
4. Select Define New Number Format… to create a new ordered list format
5. In the New Bullet dialog or the New Number Format dialog, select the list characteristics
6. Select OK
7.3 Columns
Use Columns feature for placing text in columns. 
Note: Because columns can be a challenge for users of some assistive technologies, consider whether a column layout is really necessary.
7.4 Page Breaks
Start a new page by inserting a page break instead of repeated hard returns.
7.5 Use a Table of Contents
Creating an index or table of contents to outline office document content can provide a means of navigating the meaningful sequence of content.  
The best way to generate a table of contents is after applying the predefined heading styles, such as "Heading 1" as described above, to the headings that you want to include in your table of contents. After you apply these styles, you can then create a table of contents.
To insert a Table of Contents
1. Place the cursor in your document where you want to create the table of contents
2. Go to menu item: References
3. In the Table of Contents section, select Table of Contents
4. Select the style that you want to use
To update a Table of Contents
1. Select the table
2. Go to menu item: References
3. In the Table of Contents section, select the Update Table button
[bookmark: _Toc275959790]7.6 Use Page Numbering
Numbering the pages of your document helps those reading and editing your document effectively navigate and reference its content.  For users of assistive technologies, it provides a valuable point of reference within the document.
[bookmark: _Toc275959791]To Insert Page Numbers
1. Go to menu item: Insert
2. In the Header & Footer section, select Page Number
3. Select where you would like to insert your page numbers
4. Select the style of page number you would like to use
To Format Page Numbers
1. Go to menu item: Insert
2. In the Header & Footer section, select Page Number
3. Select Format Page Numbers…
4. In the Page Number Format dialog, select the page format characteristics you would like to use
Note: These changes are applied to the predefined page format styles.  It does not create a new page format style.
7.7 Document Title
In case the document is ever converted into HTML, it should be given a descriptive and meaningful title. 
To change the title of the current document
1. Go to menu item: File
2. Select Info from the list in the left window pane
3. In the right window pane, select on the Title text box
4. Enter the Title
Note: The Title defined in the properties is different than the file name. It is also unrelated to the template name, discussed above. 
[bookmark: _Toc278376940][bookmark: _Toc282436947][bookmark: _Toc284328028][bookmark: _Toc284333457][bookmark: _Toc284342218][bookmark: _Toc284509805]Technique 8. Create Accessible Charts
Charts can be used to make data more understandable for some audiences.  However, it is important to ensure that your chart is as accessible as possible to all members of your audience.  All basic accessibility considerations that are applied to the rest of your document must also be applied to your charts and the elements within your charts.  For example, use shape and color, rather than color alone, to convey information.  As well, some further steps should be taken to ensure that the contents are your chart are appropriate labeled to give users reference points that will help them to correctly interpret the information. 
To create a chart
1. Go to menu item: Insert
2. In the Illustrations section, select Chart
3. Select a Chart Type from the Chart Gallery
4. Select OK
5. Update the datasheet with the data you would like to include in your chart
6. Close the datasheet
Note: This will open the Excel document titled “Chart in Microsoft Office PowerPoint”, where you can input the data you would like to include in the chart.   When you have done this, simply close the Excel window and the data will appear on the chart in the PowerPoint presentation.
To add titles and labels
1. In the Chart Tools menu section, go to menu item: Layout
2. In the Labels section, select the type of title or label you would like to define (e.g., Chart Title, Axis Titles, Data Labels)
To apply a predefined Chart Layout
1. In the Chart Tools menu section, go to menu item: Design
2. In the Chart Layouts section, select a Quick Layout from the scrolling Chart Layouts gallery
To change to a different predefined Chart Type
1. In the Chart Tools menu section, go to menu item: Design
2. In the Type section, select the Change Chart Type icon
3. In the Change Chart Type dialog, select a chart type from the left pane
4. Select a Chart Design from the right pane
5. Select OK
Other Chart Considerations
· When creating line charts, use the formatting options to create different types of dotted lines to facilitate legibility for users who are color blind
· When creating bar charts, go to menu item: Chart Tools > Format and in the Shape Styles section select Shape Fill to apply a texture to help distinguish the bars
· Change the default colors to a color safe or gray-scale palette
· Use the formatting options to change predefined colors, ensuring that they align with sufficient contrast requirements (see Technique 9.2, below) 
[bookmark: _Toc284509806]Technique 9. Make Content Easier to See
Here are some other things to keep in mind:
9.1 Format of Text
When formatting text, especially when the text is likely to printed, try to:
· Use font sizes between 12 and 18 points for body text.
· Use fonts of normal weight, rather than bold or light weight fonts.  If you do choose to use bold fonts for emphasis, use them sparingly. 
· Use standard fonts with clear spacing and easily recognized upper and lower case characters. Sans serif fonts (e.g., Arial, Verdana) may sometimes be easier to read than serif fonts (e.g., Times New Roman, Garamond).
· Avoid large amounts of text set all in caps, italic or underlined.
· Use normal or expanded character spacing, rather than condensed spacing.
· Avoid animated or scrolling text.
But can’t users just zoom in?  Office applications do typically include accessibility features such as the ability to magnify documents and support for high contrast modes. However, because printing is an important aspect of many workflows and changing font sizes directly will change documents details such the pagination, the layout of tables, etc., it is best practice to always format text for a reasonable degree of accessibility.
To change the text size for a default named style
1. Go to menu item: Home
2. In the Styles section, right-click* the Style you wish to modify
3. Select Modify Style
4. Under Formatting in the Modify dialog box, select the appropriate font size
5. Exit with OK
[image: ]
9.2 Use Sufficient Contrast
The visual presentation of text and images of text should have a contrast ration of at least 4.5:1. To help you determine the contrast, here are some examples on a white background:
· Very good contrast (Foreground=black, Background=white, Ratio=21:1)
· Acceptable contrast (Foreground=#767676, Background=white, Ratio=4.54:1)
· Unacceptable contrast (Foreground=#AAAAAA, Background=white, Ratio=2.32:1)
Also, always use a single solid color for a text background rather than a pattern.
In order to determine whether the colors in your document have sufficient contrast, you can consult an online contrast checker, such as: 
· Juicy Studio: Luminosity Color Contrast Ratio Analyzer 
· Joe Dolson Color Contrast Spectrum Tester
· Joe Dolson Color Contrast Comparison
[bookmark: _Toc273692193]9.3 Avoid Using Color Alone 
Color should not be used as the only visual means of conveying information, indicating an action, prompting a response, or distinguishing a visual element.  In order to spot where color might be the only visual means of conveying information, you can create a screenshot of the document and then view it with online gray-scale converting tools, such as:
· GrayBit v2.0: Grayscale Conversion Contrast Accessibility Tool
9.4 Avoid Relying on Sensory Characteristics
The instructions provided for understanding and operating content should not rely solely on sensory characteristics such as the color or shape of content elements. Here are two examples:
· Do not track changes by simply changing the color of text you have edited and noting the color. Instead use Word 2010’s “Track Changes” feature to track changes.
· Do not distinguish between images by referring to their appearance (e.g. “the bigger one”). Instead, label each image with a figure number and use that for references.
9.5 Avoid Using Images of Text
Before you use an image to control the presentation of text (e.g., to ensure a certain font or color combination), consider whether you can achieve the same result by styling “real text”. If this is not possible, as with logos containing stylized text, make sure to provide alternative text for the image following the techniques noted above.
[bookmark: _Toc284509807]Technique 10. Make Content Easier to Understand
10.1 Write Clearly
By taking the time to design your content in a consistent way, it will be easier to access, navigate and interpret for all users:
· Whenever possible, write clearly with short sentences.
· Introduce acronyms and spell out abbreviations.
· Avoid making the document too “busy” by using lots of whitespace and by avoiding too many different colors, fonts and images.
· If content is repeated on multiple pages within a document or within a set of documents (e.g., headings, footings, etc.), it should occur consistently each time it is repeated.  
10.2 Provide Context for Hyperlinks
Hyperlinks are more effective navigation aids when the user understands the likely result of following the link. Otherwise, users may have to use trial-and-error to find what they need.
To help the user understand the result of selecting a hyperlink, ensure that the link makes sense when read in the context of the text around it. For example, while it would be confusing to use “more information” as a link by itself on a page, it would be fine to use “more information” as a link in the following sentence: “The airport can be reached by taxi or bus (more information).”
To make the address of hyperlink clear when printing, you may wish to include the address in brackets following the descriptive text of the hyperlink.
To add hyperlinks with meaningful text
1. Type (or paste in) a web address and press spacebar or “Enter” to convert into a hyperlink
2. Select the link and right-click*
3. Select Edit Hyperlink (Ctrl + K)
4. Edit the text in the Text to display box 
[bookmark: _Toc284342221][bookmark: _Toc284509808]Technique 11. Check Accessibility
If you wish to check the accessibility of your document or template (see Technique 1, above), Word 2010 offers an “Accessibility Checker” to review your document against a set of possible issues that users with disabilities may experience in your file. 
The “Accessibility Checker” classifies issues as
· Error – content that makes a file very difficult or impossible for people with disabilities to understand
· Warning – content that in most, but not all, cases makes a file difficult for people with disabilities to understand
· Tip – content that people with disabilities can understand, but that might be better organized or presented in a way that would maximize their experience
To learn more about the Accessibility Checker and the rules it uses to identify and classify accessibility issues in your document, visit the Word 2010 help section (see Accessibility Help, below).  Use the search term “accessibility checker rules” in the help search box.
To use the “Accessibility Checker”
1. Go to menu item: File
2. Select Info in the left window pane
3. Under Prepare for Sharing, an alert will appear if a potential accessibility issue has been detected
[image: ]
4. To view and repair the issues, select Check for Issues and then Check Accessibility
[image: ]
5. An Accessibility Checker task pane will open, showing the inspection results
[image: ]
6. Select a specific issue to see Additional Information
7. Follow the steps provided to fix or revise the content
[image: ] 
In order to get some indication of the accessibility of your document or template (see Technique 1), then you may consider saving the file into HTML or PDF in order to perform an accessibility check in one of those formats, as described below.
To evaluate HTML accessibility
Another option is to save the document into HTML format and use one of the web accessibility checkers available online.  Such as:
· AChecker
· WebAIM Wave Web Accessibility Evaluation Tool
To evaluate PDF accessibility
If you saved your document in tagged PDF format, you can use the following tools and steps to evaluate the accessibility of the PDF document:
· Adobe Acrobat Professional
· PDF Accessibility Checker (PAC) – a free alternative provided by “Access for all” 
To evaluate PDF accessibility in Adobe Acrobat Professional
1. Go to menu item: Advanced > Accessibility > Full Check…
2. In the Full Check dialog, select all the checking option
3. Select the Start Checking button
[bookmark: _Toc284342222][bookmark: _Toc284509809][bookmark: OLE_LINK3]Technique 12. Use Accessibility Features when Saving/Exporting to Other Formats
In some cases, additional steps must be taken in order to ensure accessibility information is preserved when saving/exporting to formats other than the default.
PDF
[image: ] PDF documents are not always accessible. Accessible PDF documents are often called “Tagged PDF” because they include “tags” that encode structural information required for accessibility.  To evaluate the accessibility of your PDF document, see Technique 11 (above).
1. Go to menu item: File
2. Select Save As
3. In the File name box, type a name for the file
4. In the Save as type list, select PDF or XPS Document
5. Select the Options button
6. Under Include non-printing information in the Options dialog, ensure that the Document structure tags for accessibility check box is selected
7. Select OK and Save
[image: ]
HTML
1. Go to menu item: File
2. Select Save As
3. In the File name box, type a name for the file
4. In the Save as type box, select Web Page
5. Select Save
6. Check the HTML file for accessibility (see Technique 11, above)
[bookmark: _Toc273644400]To clean up your HTML file
1. Remove unnecessary styles, line breaks, etc.
2. Remove unnecessary id, class, and attributes
3. Remove font tags
4. Remove styles in the <head> tag
5. Ensure the <th> tags have a scope attribute
6. Remove <p> tags nested inside <th> and <td> tags
7. Check for accessibility (see Technique 11, above)
Note: you may wish to use HTML editors or utilities to help with this process.
[bookmark: _Toc284342223][bookmark: _Toc284511696][bookmark: OLE_LINK6][bookmark: OLE_LINK7][bookmark: OLE_LINK10][bookmark: OLE_LINK11][bookmark: _Toc284509810]Technique 13. Consider Using Accessibility Support Applications/Plugins
Disclaimer: This list is provided for information purposes only. It is not exhaustive and inclusion of an application or plug-in on the list does not constitute a recommendation or guarantee of results.
· Microsoft Accessibility Page
· Office 2010 Accessibility Tutorials
· Keyboard shortcuts for Word 2010
· Customize keyboard shortcuts for Word 2010
· Accessibility features in Word 2010
Other Application Features
Word 2010’s “Navigation” Feature
After you have populated your document with content and true headings have been applied, you may wish to rearrange the content.  In order to maintain the integrity and accessibility of the altered sequence, you will need to ensure that structural information (e.g., heading levels) is adjusted accordingly.  
Word 2010 provides a “Navigation” mechanism which displays all parts of the document, such as headings, paragraphs, objects, etc. in sequential order.  It helps you navigate, access, and manipulate the content.  You can move headings or subordinate text up or down, rearranging their sequence in a way that can be programmatically determined and therefore accessible to assistive technologies.
To use the “Navigation” feature
1. Go to menu item: View
2. In the Show section, select the Navigation Pane check box
3. The Navigation pane will open to the left of your document
To jump to a location in a document
1. Select one of three navigation options:
a. Select the Browse headings icon (Note: select the heading to view hierarchical headings and content below it)
b. Select the Browse pages icon
c. Select the Search text
[image: ]
2. Scroll through the sequential list and double-click* on the location you would like to jump to
To move content up or down in a document
1. Select and drag the content to a new location in the list
[bookmark: _Toc284509811]Accessibility Help
If you are interested in what features are provided to make using Word 2010 more accessible to users, documentation is provided in the Help system: 
1. Go to menu item: File
2. Select Help from the list on the left
3. Under the Support section, select the Help icon
4. Enter “Accessibility” as your search term in the Help dialog box
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3. Microsoft Word 2010 Online Accessibility Center
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